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Sending Timecode from Reaper to Titan on
another PC

This is an example of how to use Reaper - a much more powerful DAW (digital audio workstation) than
Winamp - to send timecode to Titan, assuming both are installed on two separate PCs. MIDI is being
sent over network using rtpMIDI.

Prerequisites

1. of course both computers need to be networked and configured properly (same network mask,
correct IP addresses etc.)

2. Titan PC-Suite, from v12 on (External AvoKey or T2 required - T1 or Editor Avokey does not
work)

3. rtpMIDI (see Software List, to route the MIDI signal from one computer to the other

Reaper (see Software List)

5. you may consider using the vWIMTC plugin for Reaper in order to have timecode also when
stopped or paused

P

Make it run

1. rtpMIDI

This needs to installed on both machines. rtpMIDI provides a virtual MIDI port which is then bein
forwarded over the network to other participants of this session. There is a compact tutorial provided
at the rtpMIDI website. Usually setting this up is as easy as checking the session is enabled in both
machines, and both see each other.

The two pictures show the setup which was used in the a.m. youtube video - SB-HP is the laptop
running Titan while rtpl is the session on the laptop running Reaper.
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rtpMIDI on the computer running Titan rtpMIDI on the computer running Reaper

| found that Titan is allergic to MIDI ports being added or removed while Titan is running.
The safest route is, after installing and configuring rtpMIDI, to completely restart the
computer which runs Titan.

2. Titan PC Suite

In order to initially watch the timecode open a timecode workspace window (e.g. Timecode 1) and
select MIDI as timecode source.

Timecode 1 [ = .Jl'.#jl'.f‘}]jl:}(]

00:00:00.00

3. Reaper

Launch Reaper. Load a track if you want (not required for this to function). However here are the
steps to configure Reaper correctly:
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3.1 Enable MIDI Output

In the Options menu select Preferences - this opens the preferences window. Find MIDI devices in
the Audio section. This should list the virtual MIDI port you created in rtpMIDI as MIDI output:

—
|

G REAPER Preferences

MIDI Devices a | MIDI hardware settings

Buffering MIDI inputs to make available (selectable as track inputs and/or leamable or action-bindable):

Mute/Solo Device - Mode ID
Playback

Seeking g Enabled+Control 0

Recording

Loop Recording

Rendering
Appearance

Media

Peaks\Waveforms

Fadez/Crossfades ) i Add joystick MIDI...
Track Cortral Pansls MIDI outputs to make au.?‘l\!able (selectable as track outputs):

Editing Behavior Device Mode D

Envelope Display Microsoft GS Wavetable Synth Juse cautiously]  <disabled: 1]

Automation tp Enabled 1
Mouse

et

Mouse Modifiers

MIDI Editor
Media

MIDI

Video Import/Misc Restrict MIDI hardware output to one thread Reset all MIDI devices

Plug-ns
Compatibility v | Pesetby: [v]Alnotes-off Pitch/sustain Reseton: []Play [ ]Stop/stopped seek

[ ] Find Cancel | IR

Right-click on the port in the output section and either tick Enable output from the menu...
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ﬁ REAPER Preferences It >
MID| Devices » | MIDI hardware settings
Buffering MID| inputs to make available (selectable as track inputs and./or leamable or action-bindable):
rFll'll::t;fSTclﬂ Device Mode D
ac
Seeking tpl Enabled+Cortrol 0
Recording
Loop Recording
Rendering

Appearance
Media
Peaks/Waveforms
Fades/Crossfades . _ Add joystick MIDI...
Track Control Panels MIDI outputs to make .a':.railable {selectable as track outputs):

Editing Behavior Device Mode D
Envelnpra Display Microsoft GS Wavetable Synth [use cautiously]  <disabled: 0
Automation tp 1 Enabled 1
Mouse ]

Mouss Madifiers Configure output...
MIDI| Editor
»

Media Cutput 1D
MIDI Forget device
Videa/Import/Misc Reset all MIDI devices

Plug-ns . Enable output
Compatibility v Send clock to output Play []Stop/stopped seek

I:I Find E::iba::s::. Do not send 5PP to output E Cancel Apply
Low latencv outout mode (low orecision]

... or select Configure output.. and make the settings there:
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ﬁ REAPER Preferences _‘T_ %
MID| Devices A | MID| hardware settings
- B — ! A—-———ghle as track inputs and/or leamable or action-bindable):
ﬁ Configure MIDI Output X
M
3 Mode D
5; Device name: |rtp1 | Enabled+Control 1]
RE  Alias name: |m |
Lo
=} Enable output to this device
fppl []Send clock to this deviee [ ] Mo SPP/continue
Ivlg ] Open device in low latencydow precision mode
Pe
Offset output to this device by: o N
_'l'__-: ctable as track outputs): Add joystick MIDI...
3 Cancel Mode D
Ermlay Microsoft G5 Wavetable Synth [use cautiously]  <disabled: 0
Automation tp1 Enabled 1
Mouge
Mouze Modifiers
MIDI Editor
Media
MIDI
Pl"n.ﬁd»:an,-’lmpc:rtfl'tﬂisc Restrict MIDI hardware output to one thread Reset all MIDI devices
Lig-ns
Compatibility w | Pesstby: [ Alnotesoff Pitch./sustain Resst on: [A|Play [ ]Stop/stopped seek
Enable the MIDI Ouwtput devices you wish to use by right-clicking on the Device [
|:| Find name and selecting Enable Qutput. Ok Cancel Apply

Confirm the settings with OK to close the preferences window.

3.2 Insert Timecode Generator

Rewind the timeline to 0:00:00 (simply press <Pos 1>). From the Insert menu select SMPTE LTC/MTC
Timecode Generator. This inserts this generator as new track.
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zct] - REAPER wB.08/x64 - Registered to Termporary License (Commercial license, &
Insert  [termn  Track Options  Actions  Help [Insert timecode generator
Media file... EINFG
Mew MIDI item
Empty item

SMPTE LTC/MTC Timecode Generator

I Click source
Mew subproject
Marker M
Marker (prompt for name) Shift+M
Region (from time selection) Shift+R
Tempo/time signature change marker Shift+C
Measure from time selection (detect tempa) Alt+5hift+C

Measure from time selection (new time signature)...

Track Ctrl+T
Multiple tracks...
Virtual instrument on new track...

Track from template >

Empty space at time selection

If you had already inserted an audio track then probably the timecode track was inserted on the same
track. Simply click, drag and drop it onto a new track:

03_trust-il - FX

Also, it's a good idea to bring the timecode track (at least) to the same length like the music:
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3.3 Adjust Timecode Generator

Right-click on the new timecode track, and from the context menu select Item properties:

[tern settings
[temn properties... F2
Source properties... Ctrl+F2

Group
Take
Comps

[term and take colors

[temn processing

Stretch markers

(or, with the timecode track selected hit F2).

This opens the Media Iltem Properties window:
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Media ltem Properties: Timecode Generator ,¥

]
||
||
[ |
| |

If you want then you can change length, position and other details. In any case you need to make
sure it is MTC (MIDI timecode): click on the Properties button (at the bottom). In the new little
window set the properties to Send MIDI (MTC):
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Media ltem Properties: Tirmecode Generator ¥

0:00.000

Track/project default timebase e

Project default tem mix behavior w

6 SMPTE Generator Properties

() Send audio (LTC)  (®) Send MIDI (MTC)
Frmrit&:|3ﬂ_|]] v|

Start time: [0.00:00:00 | thh:mm:ss ff)

User value 1 (0-255):
User value 2 (0-255):
User value 3 (0-255):
User value 4 (0-255):

Confirm/close both windows by clicking OK.
3.4 Route the MTC signal

This button slightly depends from your reaper version:

In Reaper v5, click on the routing button in the track controls (left to the timecode track):

or=E i

Sends, Receives, and Hard

© B ED >

In Reaper v6, right-click on the volume knob ov the timecode track.

This opens the routing window for this track. Under MIDI Hardware Output (top-right) select your
virtual MIDI port:
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Master send Parent channelz: 12~ - MIDI Hardware Output -
itp w
de Track channels: 2 \p—ﬁ |
ED [D Send to original channels w
Pan: |certer | Width: | 1007 | () e o
D P"a}had{ time offzet: [ +) | : ma | : | samples Add new receive... s
- Sends -
Add new send. .. w
- Audio Hardware Outputs -
Add new hardware output... w

Close the routing window.

4. Try it out

Essentially this should work straight away: as soon as you hit Play in Reaper, the timecode value in
Titan starts to run. It is advisable to change the time units in Reaper: right-click on the timeline or the
displayed time, and from the context menu select Hours:Minutes:Seconds:Frames.

This also works together with Reaper being controlled by Titan via MMC, like described in Controlling
Reaper from Titan on the same PC
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Internal

Disabled

| Groups

1 2
All Dimmer [ Dimmers]

You can now use this as timecode source to sync cuelists to music coming from Reaper.

| noticed a gap between the timestamps in Reaper and in Titan. This seems to be due to both, Reaper,
as well as Titan/USB Expert, and needs to be investigated further.

Also, Reaper doesn't generate timecode when being stopped or paused. There is a little plugin
available called vVIMTC which circumvents this:

e download the plugin from https://forum.cockos.com/showthread.php?t=43606 or from here
vvimtc_generator.txt

e on your Reaper computer, copy this file to %appdata%\REAPER\Effects

¢ in Reaper, disable (Mute) the previously added timecode track

e add a new empty track

e on tjhis track, add the effect JS vVIMTC Generator, add its properties (framerate etc.)

e route this track's MIDI output to your virtual port as decribed above

e record/arm this track

Now, the timecode sent is accurate also when reaper is stopped or paused.

5. How to debug

If things do not work as expected then there are some tools which help finding the fault:

5.1 loopMIDI

You may route the signal via loopMIDI as explained in Sending Timecode from Reaper to Titan on the
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same PC. Please install loopMIDI and apply the correct settings in Reaper.

Also, in this case rtpMIDI needs to be told to take its input from loopMIDI:

(&) rtpMIDI: Gber Apple Bonjour >

Konfiguration  Erweitert UOber

Meine Sessions Session

e ] (A Atviert 004
ripl
ripl

+| |- Teilnehmer: | Mame Latenz
SB-HP 1ms

Verzeichnis

Trennen
Adresse: DESKTOP-5VQ114V: 5004
2.0.0,1:5004
192,168,178, 59: 5004
+|| - Verbinden
Dieze Benutzer dorfen sich mit mir verbinden | ooplMIDT Port w | —2 &
Alle w |_ w | “—

loopMIDI shows the number of transmitted data. This number increases with every command, note or
message. With timecode, this number increases continuously and rather fast.

- o)

(#) loophIDI =
Konfiguration | Erweitert | Uber

Meine Loopback MIDIParts

Mame Durchsatz [ Sek.

0 Byte

 loopMIDI Port

E]E] Meuer Port-Mame: |loopMIDI Port 1
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5.2 USB Expert Console

Open the USB Expert Console. This must show your virtual MIDI port as connected panel (top-left).
Select the MIDI tab top-right, click Watch MIDI, in the MIDI watcher window select MIDI Input and
Raw MIDI. Now, as you send a command, it is shown in the MIDI watcher, with continuously incoming
data like this:

File Tocls  Remote  Heip

 Renet 3 Surpand e Eveniy o Servics Ted fencn MOV Tirmcods
Flier Shires o Hade
;Eﬂd::d. B Lets [ Wesier 58-HF 1
SEHE = (], Tiews Sy Mk ¥ elcher

b s Tz oMz 1 ey tha rann MDA data o Bm
BRI TzENPTE L WADH Watches - 5B-HP 1 [« [ I
sl

BAD Inpt o 10 Tl

Cormnarel Dl 1 Diata 2
Bb 7B 44 B3 7B 400 B TB 40 BS TE &0 BL TR &0 BE TR &5 Bd
78 00 B 7B 00 BY 7B 00 BS 7B 00 HA TB OO0 BC TH 0D BB 7B w | |Emply
0 BD 78 00 BE 7B 00 BF TE 00 E0 00 40 E1 OO0 40 E3 00 40 |
E4 00 40 E€ 00 40 EZ 00 40 E? OO0 40 E5 O0 40 EB 0D 40 ES Sand

00 40 EA 00 40 EB 00 40 EC 00 %0 EE 20 40 EF OO0 40 BD 40
) Bl 40 00 B2 40 00 B3 40 00 83 40 00 54 40 O0 ED OO 40

O B€ 40 00 BE 40 00 BS 40 00 BA 40 OD BE 40 0 BC

@ 00 BE 40 00 BF 40 90 FO TP Tr 21 @1 €0 00 @P
Chmion Mresnages FL 53 00 FL &0 00 F1 Té o0
Fitar 3y 00 FL 40 00 F1 &0 00 F1

oo FL 29 00 FL 30 00 F1 40 of
FL 04 00 F1 11 00 F1 25 OD F
63 00 FL 76 40 Fl1 O 90 T1 1
% FL B4 o0 PL &0 40 F1 T
FL 30 0% F1 40 00 F1 50 oD F
1L OO FL 29 00 FlL 30 90 Tl
0% FL OC 00 F1 11 00 F1 X5 o0 F1 30 O

Mo amor-mea
SESREEREE

B ACW USH pernicr connecied...

Additionally, on the Timecode tab (top-right), you should see the real timecode values running:

01 UsB Bapert Conuole 8.7.71.% - a x

File  Tocie Femote Help
 Ruset 3 Sunpand bore: Everie b2 Sevice Tes Bance MO0 [ Trecode
L'ul\funl Pafus Ew:.-da L?“':.';.w'-:de [CIRTR
Qs e e
A i T2 0M 1
. =g [ Fiason . . .
EGT2swete ! [ - 00:00:09:26 »
[ Mervm Facher Ot Temeszade

00:00:00:00

Tirsscoe Contl

0 Tersoode Taggem

Szt Meaayed X Delete b Go
Filler x
Lsgend Simet Time Sizp Tire Leop
]
Cirar Dear Trgoes L Add Triggss

& ADW USH werace connected...

5.3 MIDI-OX

Another great tool for fault finding (but also for fault generating) is MIDI-OX. One of the things you
should be aware of is that it may take the MIDI signal and doesn't forward it unless told to do so - you
may see proper MIDI messages and wonder why nothing is passed on, and as soon as you close MIDI-
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OX, suddenly everything works flawlessly. You have been warned... (Thus, usually use this together

with loopMIDI in order to tap into

the signal)

Install and launch MIDI-OX (see Software List. From the Options menu select MIDI Devices. Make
sure loopMIDI Port is listed as MIDI Input but isn't mapped to any output (yes, you can create a
feedback loop, and yes, you do not want to do this...)

i MIDI-OX - [Monitor - Input]
ﬁFiIE View Actions Options

FE: EEOE®

Window Help

=

[=]

24

&% MIDI Devices

Presets:

TIMESTAMF IN PORT STATUS DATA]l DATAZ CHAN NOTE EVENT

- @x) [

|

Cancel

Puart bMapping:

MIDI Outputs: Part Map Objects:
1] Microzoft G5 Wavetable Spnth & Channels
21 loopbdI D1 Part Tzt
3] MIDI Mapper & System
& loophIDI Port

& MIDI-O Everts
do)  MOHSYSMART oxm

| Automatically attach [nputs to Outputs during selection.

From the View menu select Input Monitor... In this window, all incoming MIDI data are shown. You
will see the cpntinuous stream of MTC Quarter Freame messages:
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i File View Actions Options Window Help
X33 BEOEY B - Imo@m Yuue 60 X
TIMESTAMF IN PCORT STATUS DATAR]1 DATRZ? CHRN NOTE EVENT -

Timing
MTC Quar

Timing C
MTC Quarter Fr

1Input Device [28 B 4P kv LOG

1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
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